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Activity 1…How to Design Your Presentation 

 
Be your own Instructional Design Specialist with a little help from Microsoft.  The 

PowerPoint AutoContent Wizard does exactly that.  You can receive help in order to 

become informational, persuasive, and make your material into powerful training slide 

shows. 

 

• When you start PowerPoint, choose the first radio button, “AutoContent Wizard.” 

 

 

 
 

• Click on the <NEXT> button 

. 

• Read the introductory screen. 

 

• Click on the <NEXT> button. 

 

• Note that the Progress Indicator now says “Presentation Type” on the left. 
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• Push the “ALL” button on the top of the page. 

 

• Choose a category from those in the right column, and make sure that is has not 

been chosen by another student. 

 

• Click on the <NEXT> button. 

 

• Where it says “Title” type in the name that appeared in the right column of the 

prior screen.   
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• Continue by pressing the <NEXT> button accepting the defaults until the 

<FINISH> button appears.  Choose <FINISH>. 

 

• Go to the top of the page and pull down VIEW to SLIDE SORTER view. Click 

on SLIDE SORTER. 

 

 
 

• When the instructor indicates, play musical chairs and move in a circle to your 

LEFT examining other types of slide shows. 
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Activity 2   My Presentation 

 
Now is the time to plan.  Think of a presentation that you will be making within the next 

four to six weeks.  You will need a title and at least four main topics covered by that title.  

You should have at least four SUB topics for each main topic.  The last sub topic should 

have two or three parts (sub-sub topics) to it.  Example: Title = Patience.  Topics = 

Observation, Processing, Evaluation, Conclusion, Course of Action.  SUB Title of Course 

of Action could be Controlled Breathing.  The sub sub topics could be taking a deep 

breath, letting it out slowly and repeating it for the next two minutes.   Now you fill in 

your own title and topics. 

 

TITLE: ________________________________________________________________ 

 

TOPIC 1:  ______________________________________________________________ 

 

  SUB TOPIC A: _____________________________________________ 

 

  SUB TOPIC B: _____________________________________________ 

 

  SUB TOPIC C: _____________________________________________ 

 

  SUB TOPIC D: _____________________________________________ 

 

TOPIC 2:  ______________________________________________________________ 

 

  SUB TOPIC A: _____________________________________________ 

 

  SUB TOPIC B: _____________________________________________ 

 

  SUB TOPIC C: _____________________________________________ 

 

  SUB TOPIC D: _____________________________________________ 

 

TOPIC 3:  _____________________________________________________________ 

 

  SUB TOPIC A: ____________________________________________ 

 

  SUB TOPIC B: ____________________________________________ 

 

  SUB TOPIC C: ____________________________________________ 

 

  SUB TOPIC D: ____________________________________________ 

 

( NEXT PAGE FOR FOUTH TOPIC) 
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Activity 2   My Presentation – CONTINUED 

 
TOPIC 4: ____________________________________________________________ 

 

  SUB TOPIC A: ___________________________________________ 

 

  SUB TOPIC B: ___________________________________________ 

 

  SUB TOPIC C: ___________________________________________ 

 

  SUB TOPIC D: ___________________________________________ 

 

   SUB SUB TOPIC 1: _________________________________ 

 

   SUB SUB TOPIC 2: _________________________________ 

 

   SUB SUB TOPIC 3: _________________________________  

 

TOPIC 5:  (A Graphic Concept) To be completed this afternoon after the 

instructor’s coaching. 

 

THIS  plus  THAT   yields  AN IDEA 

 

Example: 

 

Mother + Father  + Children   A Family 

 

 

 

A: _____________   +    B:_____________    C: _____________  
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Activity 3.   PowerPoint Templates 
(for Background Themes) 

 
PowerPoint has built-in design and content elements.  The Template option of 

PowerPoint will allow you to choose a basic design and color scheme for your 

presentation.  All of the colors and text are editable. This system is a vast improvement 

over the old blank page choice on the main menu. Before you pick a theme,  keep in mind 

your presentation setting (room, auditorium, coral, etc.). If projecting the show, make 

sure that your presentation has a high color contrast. It is now time to choose your 

backgrounds and theme. 

 

• From the opening PowerPoint Window choose Template by clicking on the 

“radio button” to the left of Template. 

• Or from the Format pull down menu select Apply Design Template in 

PowerPoint 

 

 

 
 

• Preview the different themes by clicking on them ONCE. Note the theme in the 

Preview Window to the right of the selections for a quick view of the selection. 

• Choose one of the themes by double clicking on it (or select it and click OK). 

• Another Dialog Box will pop up with your choices of Slide Layouts. Choose the 

Title Page slide layout in the upper left hand corner of the popup by double 

clicking on it (or select it and click on the OK button on the right). 
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Activity 4.   Formatting Your Slide Show 
 

You can now set up your headers and footers on both the slides and handouts.  It is also 

appropriate for you to make any changes in your Master Slide to increase contrast, 

change font, change colors, or other editing that you desire. 

 

• Go to Normal View by pulling down view to Normal.  You can also click on the 

Normal View  button on the lower left corner of any PowerPoint view screen. 

• Click on the View pull down menu and go down to Headers and Footers.  Click 

on Headers and Footers.   
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• Choose the Slide tab at the top of the page. 

• Select Date and Time by clicking in the square box next to Date and Time if 

necessary. 

• Click on the radio button (white circle) to the left of Update Automatically. 

• Choose the Slide Number box to select it. 

• Click in the Footer box to select it and the type in a short description of the 

institution that is paying for you to do this show.  Also type in your three initials 

or your name if you wish. 

• Choose the Don’t Show on Title Slide box by clicking on the empty square. 

 

 
 

Activity 4. Continued 
 

• Choose the Notes and Handouts tab at the top of this dialog box. 

• Select the Date and Time box if not already selected. 

• Choose the Update Automatically radio button. 

• Check the Header box and again fill in a shortened title to your show. 

• Select the Page number box to turn on page numbering. 

• Click on the Footer box and type in the institution that is paying you to create this 

show.  Be sure to add your three initials or name in this box. 

• Click on the APPLY  TO  ALL button in the upper right corner or all will be 

lost. 
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• Click on the View pull down menu and go to Master. 

• Choose Slide Master. 

• Click on Click to edit Master title style. 

• Pull down Format to Font. 
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• To change a font style click on the down triangle to the right of the font name and 

click on a font of your choice.  To change items such as style or size simply click 

on your choice. 

• To change colors of font, simply click on the down triangle to the right of the 

present color and choose one from the graphic now displayed.  It this isn’t the 

correct color, click on more colors.  Another graphic is displayed. Choose one 

from this graphic by clicking on it, then click OK twice if finished.  

 

 
 

 

• Click on Click to edit Master text styles and repeat the above process. Click on 

View pull down and choose Normal View or your settings will not be saved! 
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Activity 5.  Creating a Title Slide and Agenda Slide 
 

• After your have saved your Master settings by clicking on the View pull down to 

Normal View, you are ready to start on your slide show. 

• Click on Click to add title and type in the title of your show as indicated in 

Activity 2. 
 

 

 
 

• Click in Click to add subtitle and type in the organization or individual that will 

get credit for producing this show. 

• Locate the New Slide button on the top button bar or pull down insert to New 

Slide and click. 

• In the Choose an Auto layout screen pick the second one from the left on the top 

row and double click on it. 
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• Click in the Title area and type AGENDA 

• Choose the text area and type in your four topics that you wish to cover 

• Click on the File pull down menu to SAVE AS! 

• Make sure that you are in My Documents folder and give the file your first name 
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• Locate the New Slide button on the top button bar or pull down insert to New 

Slide and click. 

• In the Choose an Auto layout screen again pick the second one from the left on 

the top row and double click on it. This gives us a title slide and bulleted items. 
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• Click in Click to add title and type in your first topic 
 

 
 

• Now choose Click to add text, and add the four sub items you wrote in Activity 

2. 

• Click on the File pull down menu to SAVE! 
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Activity 5.  Adding Clip Art to your slide 

 
• Looks plain?  Let us add a piece of Clip Art by pulling down the Insert menu to 

Picture, then click on Clip Art. 
 

 
 

• At the top it will say Search for clips: type in a very short description of what 

you are looking for in the box that says, “Type one or more words.“  You can 

also pick from the category buttons below this search window. 

• When you click on your clip art choice, a sub menu pops up.  Choose the top item 

Insert Clip. 
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• Close the Clip Art Window with the close box [x] 

• If you wish to move the clipart, click on it to get handles (squares on corners), 

then get the move arrow (four headed cross arrow)  

• Want to resize the clip art?  Just select the clipart by clicking on it, then click and 

hold the left mouse button down and drag it in to make smaller and out to make it 

larger. 

• Click on the File pull down menu to SAVE! 
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Activity 6.  Preformatted Text and a Graphic 
 

A pleasant and easy way to convey text and graphics together is to use some of the 

AutoContent Wizard’s layouts.  Your production speed will increase with this 

technique. 

 

• Locate the New Slide button on the top button bar or pull down insert to New 

Slide and click. 

• In the Choose an Auto layout screen pick the first one from the left on the third 

row down and double click on it. 
 

 
 

• Click on the Click to addTitle area to add your second topic from the activity 

sheet. 

• Select the Click to add text area and fill in the four subtopics from the same 

sheet. 

• Now double click in the Double click to add Clip Art box. 
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Activity 6.  Preformatted Text and a Graphic 

(Continued) 

 

 

 
 

• Choose a topic and open the window with a single click.  

• When you click on your clip art choice, a sub menu pops up.  Choose the top item 

Insert Clip. 
• Close the Clip Art Window with the close box [x] 
• If you wish to move the clipart, click on it to get handles (squares on corners), 

then get the move arrow (four headed cross arrow)  
• Want to resize the clip art?  Just select the clipart by clicking on it, then click and 

hold the left mouse button down and drag it in to make smaller and out to make it 

larger. 

• Click on the File pull down menu to SAVE AS! 
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Activity 7.  Using Special Text 
 

There are times when you may wish to be creative or artistic with your slide presentation.  

You need words not pictures.  Here is a possible solution. 

 
• Locate the New Slide button on the top button bar or pull down insert to New 

Slide and click. 

• In the Choose an Auto layout screen pick the third one from the left on the third 

row down and double click on it. 
 

 
 

• This slide selection allows you to create a slide with a title and a large open area. 

• Place the title for you third topic in the the Click to add title area 

• Push the Word Art button at the bottom of your screen or pull down Insert to 

Pictures and choose Word Art. 
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• Double click on the style of Word Art that you want.  Remember to color 

coordinate you choice, if possible.  Push the OK button on the bottom. 

• Type in the word(s) you want displayed.  Use the sub items from your outline. 
 

 
 

• You may also want to change your font  and some of its characteristics here ie. 

Bold and Italics. Click OK when finished.  Repeat these steps for the remaining 

three items choosing new Word Art styles.  DO A FILE SAVE! 
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Activity 7.  Text with Sub Topics and Text Boxes 
 

At times you may require indented items.  This is accomplished by using the tab and shift 

+ tab keys as described below.  You can also add text boxes to screens.  It is possible to 

even put words into peoples mouths! 
 

• Locate the New Slide button on the top button bar or pull down insert to New 

Slide and click. 

• In the Choose an Auto layout screen pick the first one on the left in the third row 

down and double click on it. 
 

 
 

• Choose click to add title and type in your title (the fourth topic). 

• Type in your sub topics (from the sheet) 

• When you reach the sub topic to be indented, press the TAB key before typing the 

item.  Note: The ENTER key from the prior item must be pressed before pressing 

the TAB key.  

• To get out of the sub sub item and back to the regular sub item simply HOLD 

down the SHIFT key and tap the TAB key. This is the equivalent of the reverse 

tab key. 

 

05/15/2000    GPJ 



Microsoft PowerPoint 2000 For Teachers 
Internet and Technology Training Services, M-DCPS 

 
 

 

• Double click on the box that indicates the availability of pictures. 

• From the topic buttons choose People (click once) 

• Locate the drawing of a man talking.  There is a city in the background. 

• OPTIONAL: Callouts  
• Locate the Autoshapes button on the bottom row of buttons. Click on 

Autoshapes and move up to Callouts.  Slide to the right and pick a straight 

callout shape by clicking on it. 

• Now carefully draw a diagonal line to the left of the picture.  Wow, a callout 

appears. 

• RIGHT click on the callout when the handles are showing (the squares).  Choose 

edit text.  Type in a couple of appropriate words.  While the words are still 

highlighted click on the Bold and or Italics buttons.  Adjust the size of the 

callout with the handles and diagonal arrow heads. 

• The yellow handle will allow you to adjust the large callout arrow, in order to 

have it point to the man’s mouth. 

• Note: Text can also be inserted by clicking on the Text Box button on the bottom 

of the screen.  Then click in the callout box and type your text.  Unfortunately, if 

you move the picture this text box will not follow.  You will have to move it 

manually.  

• Click on the File pull down menu to SAVE AS! 
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Activity 8.  Acquiring Pictures 

 
If you are working in PowerPoint on a regular basis, you can never have enough 

pictures.  Here are some ways of increasing your collection. 

 

• Additional clipart is available on your compact disk (CD).  Locate the Number 2 

of Microsoft Office.  There are four disks in the Office 2000 Suite. Open your CD 

Drive in My Computer or Windows Explorer.  Open the program Setup.exe by 

double clicking.  Choose Add Remove Features button by clicking on it once. 
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• Now click on Office Tools and select it.  Then RIGHT click on Clip Gallery and 

choose Run All from My Computer.  This will put all of the clip art on your 

hard drive.  ONLY  FOR  PEOPLE  WITH  BIG  HARD  DRIVES!  

• If you have a small hard drive choose Run All from CD 

• NEXT:  Microsoft has free clip art available if you have an Internet Connection. 

• First pull down the Insert Menu to Pictures.  Click on ClipArt. 

• In the Clip Art dialog box click once on the Clips On Line button 

 

 
 

• You must have a direct connection to the web at the time you push the Clips On 

Line button or this will NOT work.  With Dial Up connections to the Internet, 

you must dial up and make the connection first. 
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Activity 8.  OPTIONAL Capture from the Web 

 
Often you see pictures and text appear on the World Wide Web that would be perfect for 

you Power Point Presentation.  You can capture them with a simple copy and paste. 
 

• Minimize Power Point and open a Web Browser such as Netscape Communicator 

or Microsoft Internet Explorer. 

• Locate a picture that you wish to place in PowerPoint. 

• RIGHT click on the picture and from the menu that pops up choose Copy. 

• On the Task Bar at the bottom click once on the PowerPoint button. 

• Click once where you want the picture to be pasted. 

• RIGHT click and pick paste.  The picture will appear in PowerPoint. 

• You can resize it with the two headed arrow or move it with the four headed 

arrow cursor. 

 

 

• Text can be lifted the same way, but highlight the text first and use the EDIT 

pull down menu to do the COPY and PASTE  (under some conditions the 

right click does not produce a popup menu with text).  If the text is a link, 

highlighting becomes tricky.  Simply highlight more than you want including 

the word prior to or after the link and it will all copy, then delete the extra 

word 

• Click on the File pull down menu to SAVE AS!
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Activity 9.  Animating Text and Pictures 

 
One of the real advantages to using PowerPoint is the ability to breath life into your 

slide show.  Some of this is color, but most of it is the animation of text and graphics. 
 

• Go to your second slide in your show or the slide you wish to animate. 

• Pull down Slide Show to Custom Animation and click on Custom 

Animation. 
 

 

 
 

• In the top left box check the item you wish to animate.  It will appear in the 

bottom box of Order & Timing. 

• Choose either to animate On Mouse click or Automatically in the indicated 

number of seconds. 

• Then click on the Effects Tab in the middle of the dialog box. 
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• In the Effects tab area choose the Entry animation by clicking on the down 

triangle, then choosing the type of entry.   

• To the right of the Entry window, use the down triangle and pick the direction of 

entry. 

• If sound is used, pick a sound.  USE   SPARINGLY! 

• When using text you may dim the text by selecting a color from the After 

animation area. Click on Don’t Dim and choose a color that is not contrasting 

with the background color. 

• For text select Introduce text to have a whole bulleted item appear at once, by 

the word, or letter. 

• If your text has indented items you must check the Grouped by box and change 

the number 1 box to the number of indentations that you have ie. 2, 3, 4, and 5.  

• You can click on the Preview button to see what is happening. 

• Use the OK button to save settings to memory and… 

• Click on the File pull down menu to SAVE AS! 

• Make sure that you are in My Documents folder and give the file your first name 
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Activity 10.  Explaining Concepts with Graphics 

 
While learning to use geometric objects is obviously an advantage to the elementary level 

of education, the same tool may be employed to explain abstract concepts. 

 

• Locate the New Slide button on the top button bar or pull down insert to New 

Slide and click. 

• In the Choose an Auto layout screen again pick the third one from the left on the 

third row and double click on it. This gives us a title slide and bulleted items. 
• Type in the title area the name that you created for this slide 

• Click on AutoShapes button on the bottom of the screen. 

• Slide up to Basic Shapes and click on the rectangle. 

• Draw a diagonal line on the left side of the screen about one inch long.  A 

rectangle appears 

• Go to AutoShapes and Basic Shapes again and this time pick a cross or plus sign 

• Again draw a diagonal line to the right of your first object  and a plus sign 

appears. 

• Again go to AutoShapes and Basic shapes and pick a triangle  and draw your line. 

• Now go to AutoShapes and Block Arrows and choose an arrow pointing to the 

right.  Draw your diagonal line again. 

• This time go back to the Basic Shapes and choose an oval  BUT hold down the 

SHIFT key as you draw the diagonal.  A symmetric CIRCLE appears. 
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• Placing text under or in the objects gives you the conceptual style. 

• Click on the Text Box button on the bottom of the screen or pull down Insert to 

Text box. 

• Click in the desired area to insert text.  Type your words.  Repeat under each 

object.  See example in slide show. 

• To change the color of the object, simply right click on the object and choose 

Format Autoshape (spilling paint can icon on left) 
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Activity 11. Introducing Sound Into Shows 

 
On rare occasions you may need sound to make a point, alert the audience to something 

unique, or just plain get their attention (Dimmed lights are not necessarily a good thing!) 

 

• To associate with either words, clipart, or pictures, simply go to the slide that you 

want the sound on and pull down Slide Show to Custom Animation.  

• In Custom Animation click on the Order & Timing Tab and choose the item 

(words or picture that you want the sound associated with). Place a check in the 

box if you already have not picked it for animation.   

• Now click in the Effects Tab and then choose the No Sound window (one click). 

•  You may now choose one of the sounds included with PowerPoint. 

•   If you have a sound file that you wish to use other than these, just click on Other 

Sound at the bottom of the list and a Microsoft open dialog box appears 

•  Direct the program to pick up a sound file from anywhere that your computer can 

reach ie. Floppy, hard drive, CD, and a network. 
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Activity 12   Creating and Printing your own shows 
 

It is now time to put this whole show together and print your presentation.  The Slide 

Sorter View allows you to view and sort the order of your slides.  The File Print allows 

you to choose what type of printout you wish to process. 

 

• To view and short your slides go to the Slide Sorter button on the bottom left of 

your screen or pull down View to Slide Sorter. 

• To move a slide simply click and hold the left mouse button down, then drag the 

slide to a location between the slides you wish to insert your slide.  A vertical line 

now appears.  Release your finger from the left button.  It has moved. 

 

 

 
 

Note:  When you click on a slide before moving a darkened box appears around it.  

The new location is always a THIN vertical line.  The view has been enhanced! 
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• In order to print (get hard copy) your slide show just pull down File to Print.  

Never use the Printer Button! You will have no control if you push that button. 

• You now have the usual spaces to choose all of your show to print or only the 

pages you type in the number(s). You can type in the number of copies if more 

than one. 

• Now you have many views to pick. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

• In the Print what: box you can choose between slides, handouts, notes pages, and 

outline view.  The most often used is HANDOUTS and set the Slides per_page to 

3 not the default 

• In the Handout dialog be sure to check Pure black and white  AND Frame slides! 
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Activity 1 

How to Design Your Presentation 

 
• Upon starting Powerpoint choose the AutoContent Wizard  p.1 

• Choose the All selection on the left frame and a type on the right  p.2 

• Go through the Wizard’s Install process p.2-3 

• Change to the Slide Sorter View  p.3 

• Review with your classmates the different types of preformatted types of 

PowerPoint presentations 
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Activity 2   My Presentation 

 
Now is the time to plan.  Think of a presentation that you will be making within the next 

four to six weeks.  You will need a title and at least four main topics covered by that title.  

You should have at least four SUB topics for each main topic.  The last sub topic should 

have two or three parts (sub-sub topics) to it.  Example: Title = Patience.  Topics = 

Observation, Processing, Evaluation, Conclusion, Course of Action.  SUB Title of Course 

of Action could be Controlled Breathing.  The sub sub topics could be taking a deep 

breath, letting it out slowly and repeating it for the next two minutes.   Now you fill in 

your own title and topics. 

 

TITLE: ________________________________________________________________ 

 

TOPIC 1:  ______________________________________________________________ 

 

  SUB TOPIC A: _____________________________________________ 

 

  SUB TOPIC B: _____________________________________________ 

 

  SUB TOPIC C: _____________________________________________ 

 

  SUB TOPIC D: _____________________________________________ 

 

TOPIC 2:  ______________________________________________________________ 

 

  SUB TOPIC A: _____________________________________________ 

 

  SUB TOPIC B: _____________________________________________ 

 

  SUB TOPIC C: _____________________________________________ 

 

  SUB TOPIC D: _____________________________________________ 

 

TOPIC 3:  _____________________________________________________________ 

 

  SUB TOPIC A: ____________________________________________ 

 

  SUB TOPIC B: ____________________________________________ 

 

  SUB TOPIC C: ____________________________________________ 

 

  SUB TOPIC D: ____________________________________________ 

 

( NEXT PAGE FOR FOUTH TOPIC) 
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Activity 2   My Presentation – CONTINUED 

 
TOPIC 4: ____________________________________________________________ 

 

  SUB TOPIC A: ___________________________________________ 

 

  SUB TOPIC B: ___________________________________________ 

 

  SUB TOPIC C: ___________________________________________ 

 

  SUB TOPIC D: ___________________________________________ 

 

   SUB SUB TOPIC 1: _________________________________ 

 

   SUB SUB TOPIC 2: _________________________________ 

 

   SUB SUB TOPIC 3: _________________________________  

 

 

 

 

 

 

P.4-5 of Manual 
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Activity 3.   PowerPoint Templates 
(for Background Themes) 

 
PowerPoint has built-in design and content elements.  The Template option of 

PowerPoint will allow you to choose a basic design and color scheme for your 

presentation. 

   

• From the opening PowerPoint window choose Template or from the Format 

pull down menu choose Apply Design Template    p.6 

 

 

 
 

• Preview the different themes.  Note the theme in the Preview Window to the 

right. 

• Choose one of the themes  

• Another Dialog Box will pop up with your choices of Slide Layouts. Choose 

the Title Page slide   pp.6-7 
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Activity 4.   Formatting Your Slide Show 
 

You can now set up your headers and footers on both the slides and handouts.  It is also 

appropriate for you to make any changes in your Master Slide to increase contrast, 

change font, change colors, or other editing that you desire. 

 

• Go to the Normal View 

• Use the View pull down to enter Headers and footers  pp.7-8 

• Setup the Slide Header and Footer to have Date and Time Update 

Automatically, have slide numbers,  use a footer to display school name and 

autor’s initials.  Don’t show this on the title slide; it is redundant   p.8 

 

 
 

• Setup the Notes and Handouts in a similar manner and then Apply to All  p.9 

• Return to the Normal View and Save your settings 

• Go to the Slide Master on the View Menu   p.8 

• Adjust the style of the fonts, colors of the fonts,  and characteristics of the 

fonts   pp.9-10 

• Apply to All and return to the Normal View  

• Save your presentation with Save AS from the File Menu 
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Activity 4 (Continued).  Creating a Title Slide and Agenda 

Slide 
 

• Be sure you have saved your Master Slide Settings and are back in the 

Normal View 
• Add a new slide 

• Choose the Title Slide in the upper left corner 

• Add your Title from your Activity 2 sheet into the Title box 
 

 

 
 

• In the Add Subtitle box fill in your schools name and your department  p.11 

• Readjust the size and shape of the box as needed. 

• Save your presentation  pp 12-13 

• Repeat the above process, but this time when you go to new slide and the 

Slide Layout dialog box pops up, choose the second box from the left on the 

top row.  It has a place to put the word agenda and a large box under the title 

to place the items from your outline sheet onto the slide 

• Click in Click to Add Title and enter the word AGENDA or similar title. 

• Click in Click to Add Text and enter the four items.  pp. 13-14 
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Activity 5.  Creating a Slide and Adding Clip Art to it 

 
• Click on the New Slide button or pull down Insert to New Slide. 

• Again, choose the second box from the left on the top row in the Autolayout 

screen 

• Add the first item from your outline into the title box 

• Place the subtitles in the text box below the title box p.14 

• Save your work p.13 

• Add some Microsoft Clipart to this slide, depending on space and 

appropriate graphic  pp. 15-16 

 

 

 
 

• Save your work 
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Activity 6.  (Continued) 

Preformatted Text and a Graphic 

 
• Create a new slide 

• In the AutoLayout window select the slide with a title, text box, and a picture 

of a man with a very big nose pointing to your left.  P.17 

• Place your title for your second topic in the title box 

• Place your work sheet to place in the four sub items for this topic. 

• Activate the Graphic box and choose a graphic that is appropriate to your 

slide, you may be asked to insert CD number 2 form Microsoft Office.  p.18 

• Be sure to SAVE your slide show NOW! 

 

 

 

Activity 7.  Using Special Text 

 
• Create a new slide 

• In the AutoLayout window  select the slide with only a title  p.19 

• Type in the title of your third subject in the title box 

• Choose the WordArt button, or click on Insert, the Picture, and finally 

WordArt  p.20 

• Choose one of the WordArt shapes and select it, a text entry box will pop up 

• Type in a short version of your first sub item for this topic 

• Do NOT hit the enter key unless you want a second line of text 

• Click the OK button 

• Move the ClipArt to a desirable place 

• Resize the ClipArt to a suitable size 

• Repeat the process above for the last three sub items 

• Save your slide show 
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Activity 7.  (Continued) 

Text with Sub Topics and Text Boxes 

 
• Create a new slide 

• In the AutoFormat Wizard choose the style that contains a title, a text entry 

box, and an man with a big nose, on the left hand side of the text box 

• Add the title of your fourth topic in the title box 

• Type in your sub topics p.21 

• Complete the typing with the sub sub topics pp.21-22 

• Add a graphic with a man talking from the ClipArt Gallery p.22 

• Place a Call Out box next to him p.22 

• Using the Text Box add the words “Read My Lips” (without the quote 

marks) p.22 

• Adjust the size and shape of the Call Out and the graphic as necessary 

• Save your slide show. 
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Activity 8.  Acquiring Pictures 

 
• Use the Microsoft Office Disk number 2 

• Set up the Add or Remove Features item p.23 

• Go to the Microsoft Office Icon and expand it 

• Locate the Clip Gallery p.23 

• Set up the system for “Run all form My Computer” p.24 

• You will now load the extensive clipart gallery 

 

 
 

• Go the the Insert ClipArt Gallery 

• Select the Clips Online feature  p.24 

• Note: Your Internet connection must be active before you choose Clips 

Online 

• Once on the web, locate the search box 

• Type in an item name that you need for your presentation. P.24 

• Select the items you desire 

• Choose the Download Link (Twice) 

• Now these items are available anytime you use the Clipart Gallery. 
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Activity 8.  OPTIONAL  Capture  from the Web 

 
• Create a new slide with a totally blank format 

• Do NOT close Powerpoint 

• Start your Internet connection 

• Go to a web page with a graphic you can use 

• Copy the Graphic p.25 

• Return to your slide show 

• Paste your graphic onto the slide 

• Adjust it’s size as necessary and place it according to your desires. 

• Save your slide show 
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Activity 9.  Animating Text and Pictures 

 
• Go to the Slide Sorter View 

• Choose your first topic slide (the one after Agenda) 

• Pull down the Custom Animation choice on the Slide Show pull down menu 

• Go to Order and timing and select your text p.26 

• Carefull animate your text on Mouse Click 

• Give it the following Effects: Fly from Left, All at Once, Grouped by First. 

• Choose the Graphic form Order & Timing  p.27 

• Give it the animated Effect of Spiril 

• Be sure to save your slide show. 

• Go to the rest of your slides and animate them in the same way. 

• Be sure to save your work after each slide 

• STOP where you are animating the indented text.  Wait for instructor’s 

procedures. 
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Activity 10. Explaining Concepts with Graphics 

 
• Create a new slide and choose the plain page with just a title on it. 

• Using the Autoshapes button create one each, a square, a cross, a triangle, an 

arrow for yields, and a circle  pp.28-29 

• Using the text box create a simple addition of ideas from your outline form 

• Change the size to suit your tastes 

• Using Format Autoshape to change the colors of the shapes.  Use more colors 

and the advanced fill designs of one color, two colors, and preset of Fill 

Effects 
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Introducing Sound Into Shows 

 
• Go to the slide you wish to have sound added 
• Pull down Slide Show to Custom Animation 
• In Order & Timing tab, choose where you want the  sound add 
• Switch to the Effects tab p.32 
• Click on the down pointing triangle 
• Choose a sound listed p.32 
• Click OK to save  
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Activity 12.  Creating and Printing your Own Shows 

 
• Go to the Slide Sorter View 

• Move the slides into any arrangement that you like p.31 
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